Welcome to the Amazing Slow Downer!
If you're a musician who likes to learn new songs and techniques by listening to the same piece of music over
and over but wish that the music could be played a little slower, then you'll enjoy Amazing Slow Downer. You
can repeat any section of the music at full speed, slow it down or even speed it up by stretching the music by
50% to 400% without changing the pitch!
You can also change the pitch up or down in semi-tones or fine-tune in cents (100ths of a semi-tone) to suit
your instrument.
Amazing Slow Downer program works with your CD-ROM drive or MP3/Wave/WMA/Ogg/FLAC/AAC/M4A
files on your hard disk and does all processing in real-time - no time wasted on recording or processing!

Setting up the sound card

We assume that you’ve successfully installed Amazing Slow Downer on your computer. If not, refer to the
readme.txt file for additional information.
To be able to use Amazing Slow Downer you need to enable the Wave Out portion of your sound card.
You also have to set the output signal to an appropriate level. This is done using the standard Windows mixer.
Use the Options Menu, Volume Control to access the mixer and select the Playback item.
The standard Windows mixer icon should appear on your task bar if you’ve ticked the "Show volume control
on task bar" box in the Multimedia properties window.
Double click on the icon. You should now see the Mixer window.
If the standard Windows mixer icon does not appear on your task bar, do this:
Click the "Start" button on the task bar.
From the menu, select "Program" and then select "Accessories".
Now select the item marked "Multimedia" and then "Volume Control".
You’ll see something like this:

Activate "Wave".
Set the volume control to an appropriate level.
Set the balance control to the center.
If you don't use the other volume controls, de-activate them.

1. Main Window

This section explains the basic working of Amazing Slow Downer so please give it a couple minutes. It might
be a good idea to print it out.
Amazing Slow Downer is actually two program in one - a CD Player and a File Player that shares the same
user interface. You select which one to use with the pop-up menu button top left in the main window screen,
key command [W].

a. Transport
With some exceptions, the transport controls work the same way as ordinary tape recorder controls.
You can control the program entirely from the computer keyboard, making it easy to sit in front of the computer
with your instrument in your hand without having to use the mouse, Default Keyboard Shortcuts.
This is how the different controls work:
Clicking the Play button starts the playback from the start position shown in the locator boxes.
Clicking the Continue button starts the playback from the position shown in the time display.
The Stop button is used to stop the music. It's possible to automatically rewind a bit whenever the Stop/Pause
button is clicked, Preferences - Controls.
The Cue slider above the transport controls is used to fast forward/rewind the music for easier positioning. You
may only forward/rewind between the selected start and end points.
Note: The spacebar key toggle between Play/Stop or Pause/Continue depending on the settings in the
Preferences - Control dialog.
Amazing Slow Downer is processing the sound in real-time during playback using advanced DSP (Digital
Signal Processing) techniques.

b. Looping
If you check the Loop item, the current track will loop between the time positions in the locators, keyboard
shortcut: [L].
The locator boxes display the position of the music in minutes, seconds and frames. A frame is 1/75 of a
second.
You can enter a new position by clicking the appropriate up/down arrows, by typing in the controls or by
moving the slider below. When typing the values in, use the Enter key to finish.
Clicking on a slider arrow will change the position one second, clicking in the area between the handle and the
arrow will change the position ten seconds.
The marker buttons, labeled [Start Pt.] and [End Pt.], next to the locator boxes let you select a section of
audio while it is playing through.
Keyboard shortcut: numeric keypad [2] and [5].

Keyboard shortcuts:
Start slider: Decrease/increase position by one second - Numeric keypad [4] and [6]. Add Control key for frame
changes.
End slider: Decrease/increase position by one second - Numeric keypad [1] and [3]. Add Control key for frame
changes.
Cue slider: [Left Arrow] and [Right Arrow].
Press [Z] or [X] to slide the current loop backwards or forwards with the same amount as the current length.
Press [C] or [V] to nudge loop backwards or forwards by one frame

c. Presets
You can store and recall up to ten presets per song with the help of the [0]... [9] keys on the main keyboard.
The start and end positions, speed/pitch/mix and loop settings as well as the text in the text box below the start
slider are stored. You can enter comments for each preset in the textbox provided.
When the Preset text box has input focus, all key commands are disabled so that you may enter any necessary
comments.
The program automatically remembers what CD or audio file the settings belong to. The settings are stored in
two files in the application data folder.
Press [Control] + [0]...[9] on the main keyboard to store your settings, [0]...[9] on the main keyboard to recall
your settings and [Ctrl] + [L] to clear the presets.
Pressing the [O] key (Auto Create Preset), allows you to set the loop start and end points (as a preset) on the fly
while playing. The preset will have the start/end positions auto set as name and incremented as being entered.
This makes it easy entering the different structure parts of the song in one go.
Right click in the text box area to display a drop-down menu that duplicates the keyboard commands.
With this menu you may also import and export presets. Use that for having more than one set of presets for a
CD/audio file, backing up and/or moving the presets to other computers.

d. Track List
Track/File selection
CD Player - to select a new song, just click in the Track list.
File Player - open a new file (File Menu - Open). The file will show up in the track list. The track list will
display the most recent used files for easy access to them whenever the program is started.

You may also use the Control key + Up and Down arrows on the computer keyboard to select another file or
track.
Double clicking on a track/file starts playback.
You may also re-arrange files by dragging and dropping the files to a new location (File Player only).
Track List Menu
Right clicking in the track list will display a menu with selections for opening, saving or locating files, sorting
or clearing the list as well as importing (.m3u and .pls) and exporting lists (.m3u).

File Menu
The "Delete" item on the File Menu This lets you remove a file from the track list, key command [Delete].
M3U files
M3U (MPEG Audio Layer 3 URL) is a computer file format that stores multimedia playlists.
It was originally implemented in Winamp, although it is now supported by many applications, including VLC
media player, Real Player, Windows Media Player, iTunes, QuickTime Player and most other Windows
players.
An M3U file is a plain text file that contains the locations of one or more media files that the mediaplayer
should play. Each location is placed on a new line. The locations can be either absolute or relative local
pathnames (e.g., "C:\My Music\Chanson.mp3" or "Chanson.mp3") or they can be URLs. The file can also
include comments, prefaced by the "#" character.
In extended M3U, "#" also introduces extended M3U directives. The file is saved with the "M3U" or "m3u"
filename extension.
A more modern version with Unicode support is called M3U8. Amazing Slow Downer supports both formats.

e. Sound Processing
Amazing Slow Downer is processing the sound in real-time during playback using advanced DSP (Digital Signal
Processing) techniques.

Slow down type
The Slow Down Type drop down menu beneath the Equalizer This lets you select between four different slow
down algorithms.
Type IV has the overall best sound quality but also uses a lot of processing power and might not work on slower
computers.
Type I, II and III uses very little processing power but also has worse quality.
Depending on what type of music and what instrument you are focusing on, use the one that suits your music
the best.

You may also bypass the processing completely. Use key command [A] to toggle between various types, key
command [D] to disable/enable processing.
Stretch / Speed
The slider labeled Stretch adjusts the Time Stretch (slow down factor). This is where you select the amount
(expressed as a percentage value) by which the recording should be stretched. A positive value will slow the
music down while a negative value will play it back faster.
100% means that the time is stretched by 100% and the music will be played back at half the tempo.
Speed / Stretch
You may want to display the slow down factor as speed change. In this case, 100% means full speed, 50%
means half speed, 25 % means quarter speed etc. Select Speed instead of Stretch in the Preferences - Controls
dialog.
To reset to the original speed, hold down the Control key while clicking on the slider. Use key command [T] to
toggle between full-speed and the previous setting. See Default Keyboard Shortcuts for other useful key
commands for setting the speed.
Pitch
The slider labeled Pitch adjusts the pitch i.e. the tuning and transposition.
To adjust the tuning, move the slider by dragging the handle or by clicking in the area between the handle and
the arrows. As an example: to change the key from C to E, raise the pitch by four semitones. Key command: [/]
or [*] on the numerical keypad.
To adjust a tune that is slightly above or below standard concert pitch, click the left or right arrows. Key
command: Shift + [/] or [*] on the numerical keypad.
The current setting is displayed at the status bar at the bottom of the screen.
Holding down the Control key while clicking on the slider resets it to a zero position.
Use key command [P] to toggle between no transposition and the previous setting.
Note: Raising the pitch an octave is sometimes useful when transcribing bass lines and low-pitched instruments.
Mix - Left/Right
The slider labeled Mix adjusts what channel or mix of channels you are listening to. Normally you use both
channels - center position. However, sometimes the instrument you are transcribing is more prominent on one
or the other of the channels. You may then choose to listen to only the left, only the right or any mix of the
channels you like. The music is always sent to both the left and right channels of the sound card.
Holding down the Control key while clicking on the slider resets it to a center position.
Keyboard shortcuts:
[+] / [ - ] (Numeric keypad) - Increase/decrease speed.
[ * ] / [ / ] (Numeric keypad) - Raise/lower pitch in semi-tone steps, add [Shift] key for cent changes.
The current settings are shown in the status bar at the bottom right of the window.
You can also double click on the digits in the statusbar and type in the desired values

Volume slider
Adjusts the playback volume, key command [Up/Down arrows].
Stereo playback on/off
The ST check box This lets you toggle between stereo and mono playback, key command [S].

Graphic Equalizer - EQ
This This lets you boost or cut the volume at different frequencies. For example, you can boost the mid-range to
hear a particular instrument more easily.
The graphic equalizer has seven preset frequency bands ranging from low bass to high treble - 60, 150,
400,1000, 2400, 6000, and 15000 Hz.
Moving the slider upward boosts the selected frequency band, moving it downward cuts it. Boosting the audio
signal too much may result in clipping or distortion.

Holding the [Ctrl] button down while clicking on a slider sets the volume of the selected frequency band to a
flat position.
Holding [Control] + [Shift] down while clicking on a slider sets all the sliders to a flat position.
You can store and recall up to ten presets for the EQ. Press [Control] + [Shift]+ [0]...[9] on the main keyboard
to store your settings and [Shift]+ [0]...[9] on the main keyboard to recall your settings. Right click on a EQ
slider to display a drop-down menu that duplicates the keyboard commands for storing and recalling the presets.
If you don't need any equalization, turn it off by un-checking the EQ button, keyboard shortcut [Q].
Karaoke / Vocal Remover - KA
The word "Karaoke" is Japanese for "empty orchestra". With the Karaoke function enabled, you may, by using
a stereo cancellation algorithm, reduce or remove vocals or certain instruments from a song. The idea is that
what are recorded and placed in the middle of the stereo field may be removed, leaving behind what is unique in
the left and right channels. The result depends on how the material is recorded, some songs will yield excellent
results, others not. Note that the source must be a stereo recording.
Amazing Slow Downer has two different versions of the stereo cancellation algorithm, one that results in mono
output (the ST button unchecked), the other with stereo output (the ST button checked) where the stereo image
will be kept intact.
Use the Mix slider to "zoom in" the instrument/vocals, it may not always be recorded in the exact middle of the
stereo field. The Karaoke function will usually also remove the bass, kick/snare drum etc. Use the EQ “Low”
slider(s) to "get back" some of the lower frequencies and the “High” slider(s) to "get back" some of the higher
frequencies. Raising the “Middle” slider(s) will bring back the center channel that was removed. In stereo
mode, having all three sliders all the way down will add nothing back and in mono mode, having all seven
sliders in the middle position will add nothing back.
Use this to practice to music with vocals/soloists removed or to ease transcription with unwanted instruments
removed, keyboard shortcut [K].

f. Various
Eject a CD
The Eject button is used to open and close the CD-ROM door (CD Player only), keyboard shortcut: [Control]
+ [E].
Hold a short section of audio
By using key command [H] you may hold/sustain a short section of audio. This way you can “freeze” the
music. While [Hold] is enabled, you may use the [Right Arrow] to move forward a short section. The [Left
Arrow] will move back one second. The length of the “frozen” section is determined by the "Read Buffer Size"
setting in the Preferences - Audio dialog. Pressing [H] again will release the audio and continue playback.

The Calculator Keypad

To be able to control the software easily, you may use the calculator keypad for the most common functions.
Note: The spacebar key toggle between Play/Stop or Pause/Continue depending on the settings in the
Preferences - Control dialog.

2. Menus
The menubar contains four submenus named File, Edit, Options and Help.

FILE:
Open
Opens Wave, MP3, Ogg Vorbis, FLAC or WMA (Windows Media Audio) files for playing. The files will show up in the track
list for easy access to it the next time you start the program.
You may also open files by dragging them onto the program icon on the desktop (this starts Amazing as well) or by
dragging files into the program window.
If you have Apple’s QuickTime installed on your computer you may open a lot of other file types as well.
Read more here about different types of Audio Files.

Open Playlist
This lets you open previously saved play lists (.m3u8, .m3u and .pls format).

Import Playlists
This lets you import playlists from your Windows Media Player or iTunes library.

Save song as
Save the current song displayed in the track list as a wave file or as an encoded file.
Only the portion set with the locator boxes (Start and End) will be saved.
If you select the “Processed” option in the displayed dialog, the current settings for Speed/Stretch, Pitch, Mix
and EQ is used. You may elect to save the file as a mono or stereo file.
You may also set the number of repetitions of the set loop that should be saved.
When saving files, please note that the volume control on the main screen has no effect. This is intentional so
that the files are saved with full volume and not with a possible zero or low volume. The downside is that when
saving processed files, this may result in distorted sound if you add too much of the EQ. So please check the
sound with the volume control set to maximum before saving.

Note: To be able to save as a mp3 file you need to download and install a free mp3 encoder called lame_enc.dll.
It may be downloaded from various web sites, such as: http://www.geocities.com/ragedwolf123/now.htm

Save all songs as

Save all songs in the track list as wave files or as encoded files. Else exactly as the “Save song as” menu item.

Save Playlist As
This lets you save play lists in .m3u8 (Unicode) or .m3u format for later importing.

Recent Playlists
Will display the ten latest play lists.

Refresh Track list
Updates the CD track list if needed.

Find File
Locates a file on the hard disk.

EDIT:
Delete
Delete the selected file from the track list.

OPTIONS:
Remote Control
It's possible to control Amazing Slow Downer with a remote controller from your TV, VCR, CD or Stereo.
This allows you to stand with your saxophone or sit at your piano in another part of the room than that where
you keep your computer and very easily control the software. You'll need a special hardware device called
"Irman", hooked up to your computer. The device connects to one of your serial ports and doesn't need any
external power as it uses some of the unneeded serial port wires.
To use this feature, you must also download a free plug-in file from Roni Music website.
Direct download:
http://www.ronimusic.com/pluggins/asd_rem.zip

The Remote Control Dialog is used for setting up the "Irman" device once it’s connected. This dialog box is
disabled until you move the downloaded "plug-in" file (asd_rem.dll) into the folder where you keep the main
Amazing Slow Downer file (Amazing.exe).
Once this is done, first set the "comport" to the right value, press "apply" and then configure the buttons by
pressing one in the window and then the corresponding one on your remote.

This "plug-in" lets you control all basic features of Amazing Slow Downer, such as play, stop, speed, pitch,
start, end settings, etc.
It's also possible to close the software and even shut the PC down by remote.
The "Irman" device
General Information
”Irman” (Infrared man) is a small (8x5x2 cm; 3x2x1 inch.) device that allows you to control your PC with the
remote from your TV, VCR, CD or Stereo. It's specially used to control Amazing Slow Downer from
anywhere in the room. The remote control dialog allows you to define exactly which keys on your remote you
want to use for Amazing Slow Downer. This hardware has been tested with over 40 different brands of
remotes, they all work.
Hardware Information
There are two versions of the Irman, one with a case called the normal version and one without a case, a circuit
board with all components soldered on, called the hobby version. The normal version costs $35.00 which is
payable by credit card, cash or wire, while the hobby version costs $25.00 and is only payable by cash or wire.
Please go to the Irman homepage for more information about the Irman device and how to buy it.
http://www.intolect.com/irmandetail.htm

Volume Control
Opens the Playback section of the mixer. Key command: [Ctrl]+[P].

Get freedb Info
What is freedb?
freedb is a number of servers set up on the Internet. These servers contains CD-information such as the CD's
artist, disc title, track titles and other information. If you are connected to the Internet, this Roni Music software
can connect to one or more of the freedb servers and query the database for information about the CD that you
currently have in your CD player. When the info is downloaded, it will show up in the track list. It is also saved
in the cdplayer.ini file located in the C:\Windows folder, so that the next time you insert this particular record,
the info is already available.
What server?
This database is hosted on various servers around the world. By pressing the "Get List" button, the program will
try to fetch the current list directly from the internet. Then select one that is close to you by double clicking in
the field above the "Get List" button.
Proxy or not?
There are two different protocols to access a freedb server: Direct TCP/IP (also called CDDBP database
protocol) and HTTP - hypertext transfer protocol. CDDBP is recommended because all freedb servers support
it. But if you are behind a firewall, you will need to use the HTTP protocol - check the "Use proxy" item.

Retrieve Disk Info
When everything is set up correctly, click the "OK" button. If you are not already connected to the Internet, you
will be asked to do that. The freedb database is then queried and if the CD is found, the info is stored in the
cdplayer.ini file and the track list is updated.
The cdplayer.ini file
The Windows internal CD player uses a file called cdplayer.ini to store information about CD's. This Roni
Music software (and most other CD Player software) also uses this file for getting information about song titles,
artists etc. This text file is stored in your Windows directory (WinNT for Windows 2000/XP/NT systems).
Note:
Freedb started out as a hobby project a few years ago and was named CDDB, acronym for Compact Disc Data
Base. The whole project was open source, free and released under GPL license. In 1999 a company named
Escient somehow took over the project and they have since then tried to cash in on the original CDDB project.
Now Escient has changed name to Gracenote and now has the rights to the original CDDB database. Gracenote
has also started a slightly improved CDDB version named CDDB2 which is far from free or open source and
Gracenote now tries to get developers to sign a contract to use their CDDB2 database. They plan to stop the old
CDDB database completely but they still keep it up for programmers who have signed up to use CDDB2 which
Roni Music have not.
The contract is very complicated and restrictive. Many persons (including myself) don't like that this whole
project where individuals has built up the database has now become commercial. Fortunately this project was
originally an open source project so in 1999 a similar service named freedb started. This program has now been
modified to connect to freedb.org instead of CDDB and since Gracenote has registered CDDB as their
trademark this program has been modified to mention freedb on all places where it previously used CDDB.
The homepage for the original CDDB™ database is http://www.cddb.com. CDDB™ is an acronym for
Compact Disc Data Base and it is owned by the company Escient® / Gracenote®.

Preferences
This menu item opens the Preferences dialog that lets you control various settings of Amazing Slow Downer.
Settings are grouped under a series of 'tabs' revealed by clicking on the buttons at the top of the Preferences
dialog.

Audio Settings
Here is where you make the settings concerning the playback and processing of the music.
Audio Card Driver
This menu lists all the available Audio Card Drivers on your system. It will at least show a couple of MME
(Multi Media Extension) drivers. If you have Direct X installed, it will also display the available Direct X
drivers. With older/slower computers Direct X drivers may work better, with newer/faster computers either will
work well. Select the one that works best with your computer.
Use the output section of your Mixer to enable the Wave section and set an appropriate output level.

Sample Rate
The highest frequency a digital audio recording can reproduce is half the sampling frequency. This means that a
higher setting will increase the audio quality but will also increase the time taken to process it.
A CD is always recorded with a sampling frequency of 44100 Hz, audio files may have been recorded with any
sampling frequency.
You may here choose to lower the playback frequency and thus decrease the processor work by selecting the
22050 Hz or 11025 Hz items. The 44100 Hz item leaves the sample frequency of a CD unaffected but may
lower it for an audio file. The "No Change" option does not at all change the sample frequency.
Note: Audio files with a lower sampling frequency will not be "up-sampled" to the given setting.
Pre-filter
When using a sample frequency setting of 11025 or 22050, you may need to filter out some of the higher
frequencies. Check this item if higher pitched sounds, such as a cymbal, sound distorted. This increases the
processor work.
Play Buffer Size
This setting adjusts the size of the playback buffers. Depending on speed of your computer, the audio hardware
and its driver, you may be able to adjust this value. A smaller setting will give more exact positions when
setting loop points “on the fly” with the marker buttons, a higher value will make the average strain on the CPU
lower. A too low setting may give bad audio quality such as clicks, pops and dropouts. Try to find the lowest
working setting on your particular computer.
Read Buffer Size
This setting adjusts the read size of the original audio. A larger setting may work better on some computers, a
smaller setting makes the program reacting faster for pitch and speed changes.
Note: Some CD-ROM units may not be able to read large chunks of data. If you get an error message, try using
a lower setting.
Slow Down Quality
The sound quality setting for the corresponding slow down type. Higher usually means better sound quality but
uses more processing power.
Pitch change affects speed
Normally changing the pitch does not affect the speed or vice versa. However there may be situations when you
do want this to happen. Say you have recorded something from a tape recorder running at a slightly different
playback speed than the original recording or if you are recording old 78-rpm records at 45 rpm.
You would then want a pitch change to affect the speed as well. If so, enable this item. This will disable the
Speed/Stretch slider and only the Pitch slider will be active.
To find out how to set the Pitch slider, either use your ears and adjust it until you are satisfied or pick up your
home calculator, take a deep breath and read on. Here’s an example:
A 78 rpm record played at 45 rpm has a speed ratio of 45/78 = 0.576923 which means that the speed and pitch
is lowered by the same number. Expressed in semitones that equals to 12*log2(0.576923) = -9.52259
semitones. So to get the music back to the original speed and pitch, raise the Speed slider to 9.52. Simple?

Another use of this function is to set the Pitch slider to -12. This will slow down the music to half speed and
lower the pitch one octave. You will then get a feeling how transcribing was done before software as Amazing
Slow Downer was available. Not everything was better in the old days.

Controls
This is where you make the settings for controlling the behavior of some of the buttons.
Spacebar key toggles between
You may start and stop playing by pressing the spacebar key.
If you want to repeat a certain section over and over, choose the Play / Stop item.
If you want to continue where the music stops, choose the Pause / Continue item.
Delay before playback
Here you may chose to delay the playback of a track between 1 and 10 seconds.
Rewind on stop
When clicking the Stop/Pause button, you may automatically rewind the start position shown in the time
display for a desired amount of time.
This makes it easier to repeat a short phrase without having to adjust the start position.
Wait between loops
Here, you select what will happen when playback reaches the loop end point (if loop is activated):
1. Immediately restart playback from the loop start point.
2. Wait a specified number of seconds before restarting the loop. ASD may adjust this to make it sound more
musical.
3. Wait the same amount of time as the current loop length. Note: This setting is not sample accurate, so don’t
use it to check if your “timing” is good or bad.
Change speed at new loop
Here you may choose to increase the tempo after a specified number of loops. Increment will continue for the
entered number of steps, then restart at the original speed.
To disable the speed change, set the increase speed box to 0%.
Change pitch at new loop
Here you may choose to change the pitch/key after a specified number of loops. Increment will continue for the
entered number of steps, then restart at the original pitch/key.
To disable the change, set the change pitch box to 0.

Key Commands
There are numerous functions in Amazing Slow Downer that can be performed via key commands. If you want,
you can customize the existing key commands to your liking, and also add commands for functions currently
not assigned any. All this is done in the key commands dialog.
The dialog displays a list with two columns labeled “Command” and “Key Combination”. The left column of
the list shows all commands and the right column shows the assigned key combination.

To add or change a key command for the selected item in the list, click the "Type a new key combination" field,
type the key command and then click the Set button. You can choose between any single key or a combination
of one or several modifier keys (Ctrl, Shift and Alt) plus any key.
To remove a key command, select it in the list and click the Remove button.
Clicking the Reset All button will reset all key commands to the default factory settings. Note that this
operation will replace all your customized key commands and can’t be restored.
Also note that you can’t reassign the menu item commands.

Hot keys
By selecting "Hot key commands" from the drop down menu top left, you may also enable key combinations
that Amazing Slow Downer will respond to regardless if it's the foreground application or not; it just needs to be
running. This way you don't have to switch to Amazing Slow Downer to start or stop it when for example you
are working with your note scoring software.
Hot keys should only be used if you want to control Amazing Slow Downer while it's in the background. The
key combinations you enable here will NOT work in any other application as long as Amazing Slow Downer is
running .

MIDI (Musical Instrument Digital Interface)
The MIDI Command dialog enables you to set up Amazing Slow Downer's response to MIDI input so you can
use MIDI messages to control the playback of Amazing Slow Downer. You may execute any command that
have a keyboard shortcut in Amazing Slow Downer.
To control via MIDI you need to have a MIDI input on your computer and you need to have some kind of
controller that generates a MIDI message. This could be a MIDI keyboard, the sustain pedal connected to your
MIDI keyboard, a foot pedal or any device capable of generating MIDI messages.
MIDI Settings
The "Input" drop down menu lets you select what MIDI input port to respond to. To disable MIDI control,
select the "No device selected" item.
The "Respond" drop down menu lets you select when Amazing Slow Downer will respond to MIDI messages.
"Foreground only" means Amazing Slow Downer will stop responding when another application is brought to
the front,
"Always" means Amazing Slow Downer will respond to MIDI events when in background as well.
Configuring
When you press a note or pedal you will see the MIDI message in the box labeled "Press a MIDI unit to create a
new command". If this MIDI message is what you want, select a "Command" such as "Play" in the list box
above and click the "Set" button. To remove an item, select it and click the "Remove" button.

Some commands can be mapped to the same MIDI message, in particular controls that are meant to be
controlled continuously such as "Volume Up/Down", "Rewind/Forward", "Raise/Lower Pitch" and
"Decrease/Increase Speed" . These would normally be mapped in pairs or you might get strange behavior.
Hardware MIDI controllers with faders, knobs and data/jog wheels may generate their MIDI controller
messages in several different ways but some are more common and here is how Amazing Slow Downer works
for the following commands (this is a bit technical):
If you enable the "Jog" checkbox, the selected command will respond to MIDI controllers where the data value
is in the form of "2's complement", with bit 6 as the sign bit. Positive numbers are sent for clockwise rotation.
This is how most "jog wheel" works.
For example: 4 ticks clockwise rotation: B0 nn04, 3 ticks counterclockwise rotation: B0 nn43
If you disable the "Jog" checkbox, the selected command will respond to MIDI controllers with data values
between 0 - 127. This is how most data sliders and faders work.
"Rewind/Forward" only responds to "jog wheel" controller data.
Note:
Amazing Slow Downer will respond to note on/off, controller and program change messages only.
Note that you may set a command for a note on event as well as different command for the note off (release)
event.
All controller events less than 121 (except controller 64 to 69 - hold, sustain etc) are continuous meaning you
might use them to control the volume, rewinding, speed change etc.
Controllers 64 to 69 are switch events and react to two values only (sort of on/off) and are better suited for
toggling playback etc.
To get familiar with MIDI , please read more here:
What is MIDI?
The MIDI Specification

Miscellaneous Settings
Here is where you make some additional settings.
Zoom
You may run Amazing Slow Downer in a number of different sizes. Select one of the pre-defined sizes that suit
your screen/taste.
Show tool tips
Here, you choose when tool tips are displayed. A tool tip is a tiny window displaying some helpful text when
the mouse cursor pauses over one of the controls. Select between: “Always”, “When stopped” and “Never”.
Loop Play list
If the Loop function is off and the Start and End positions are set to set to their initial positions, checking this
item will make playback start over with the first song when the last song is finished.

Auto start next track
Provided the Loop button is off and the Start and End Positions are set to their initial positions, checking this
item will automatically play the next track after the current one is finished.
Display ID3 title/artist info
Many compressed audio file formats such as mp3, wma, etc may contain information about the performer and
the song name. If you want this info to be displayed instead of the file name, check this item.
Display CD-Text info
Some audio CD’s (not that many) may contain information about the artist and song titles. If you want this info
to be displayed in the track list, check this item. However, reading this information may be very slow, so if you
find updating the track list to be slow when changing a CD or starting the software, uncheck this item.
Reverse speed slider
As the default setting, dragging the Stretch/Speed slider to the right will decrease the speed of the audio.
However, when the Stretch/Speed slider is set to Speed, it might feel more natural to increase the speed by
moving the slider to the right. if you want this behavior, check this item.
Display slow down as speed
Choose between displaying the slow down as changing the speed or changing the amount of stretch.
Auto load preset
Check this item if you want Preset 1 to be automatically loaded when a song is selected.
Recall loop points only
When you recall a preset, the start and end positions, speed/pitch/mix and loop settings as well as the text in the
text box below the start slider will be recalled. Check this item when you want only the start and end positions
to be recalled when recalling a preset.
Reset on track change
The speed/pitch/mix and loop settings will be reset to their default values when selecting a new track/song.
Always on Top
Check this item to keep the Amazing Slow Downer window on top of all other windows.
Automatically check for updates
Check this item to automatically check for updates whenever the software is started.
Volume control affects saving
When saving files, the volume control is normally disabled to avoid saving files with a too low volume.
However, when using the EQ and boosting frequencies, this may result in clipping/distortion. Enable this item
for the volume control to have affect when saving.

CD Device
Here is where you set various options concerning the CD-ROM device.
(Be warned, this is a jungle, nobody knows what do work or not).

CD-ROM access method
Here you select the way Amazing Slow Downer “talks” to your CD-ROM device. Depending on the Windows
version you are using, you may or may not be able to select between all the four choices. There is no difference
in sound quality or affectivity between them so just use one of the selections that work OK.
1 ASPI, short for Adaptec SCSI Protocol Interface, was included with the Windows 95 and 98 operating
systems. Despite the name, ASPI isn't only SCSI - it also enables a program to access non-SCSI drives such as
IDE/ATAPI CD-ROM's but you cannot access USB CD-ROM's. Windows Me, NT, 2000 and XP does not
come with ASPI drivers installed but it’s possible to install them for use on Windows NT/2000/XP operating
systems with good results.
2 SPTI, short for SCSI Pass Through Interface, is a minimal "ASPI" that Microsoft includes with all versions of
Windows newer than Windows Me. It works as ASPI with the limitations that you need to be logged on with
administrator rights. Works OK with USB CD-ROM's.
3 Native Win32, is the default and preferred way of accessing CD-ROM devices on Windows Me, NT, 2000,
XP and Vista. It works as good as ASPI and also makes it possible to access USB CD-ROM's. From the Device
Manager, get the properties of your CD player and make sure "Enable digital CD audio for this CD-ROM
device." is checked. This is the default state for XP but not for 2000 or Me.
4 CD RAL, works as ASPI but also makes it possible to access USB CD-ROM's. This method is only available
if you have Windows Media Player 7 or higher installed and are running Windows 95/98/Me or 2000.
CD-ROM Device
Select the CD-ROM device the program should use.
CD-ROM Type
The command set to be used for the CD reader.
Unfortunately, different CD players use ASPI calls in different ways. All IDE CD players use ASPI calls in the
same way.
If you have an IDE device (you probably have), select the IDE-ATAPI item.
SCSI units uses their own command set. Select the item that corresponds to your SCSI drive. If your brand is
not listed, try another selection. It may work anyway.
If you have a SCSI device, select one of the SCSI items.
The software makes an educated guess to determine what command set to use. Recognized CD-ROM types are
listed with the correct drive type. Unrecognized devices are listed as SONY by default.
Synch correction
With some CD-ROM drives, every time the music is read, the data comes in slightly shifted. If you hear strange
clicks and pops, select a synch width between 1-8 to correct for synch errors. The number indicates the number
of frames that are used for sector synchronizing. Start with the lowest number and increase as necessary.
If everything sounds fine without sector synchronizing, don't enable it since it uses some of your computer’s
processing power. Reading may even be worse if using a bigger synch width than needed.

DAE Speed
Some CD-ROM drives support the setting of the Digital Audio Extraction speed. If you experience problems
with playing, try decreasing this speed. If not, use the Max Speed setting. This feature only works with
ATAPI/IDE drives.
Sense CD change
With this item enabled, the program automatically senses if the CD door is opened or closed. If you experience
problems with playing, un-check this item. When you change CDs, you must use the File Menu Refresh Track
list command to fill the track list with information about the new CD.

Encoding Settings
Since you may save the output file in various formats, you use the Encoding Settings dialog to select the desired
format. The available formats depends on what encoders you have installed on your computer.
Select what encoder to use with the drop down menu. Then select the desired bitrate with the next drop down
menu.
In order to encode files to Windows Media Audio format, you need to install Windows Media Player. This will
also install an encoder that this Roni Music software detects.
Windows comes with a simple built in MP3 encoder. This allows for a maximum bitrate of 56 kBit/s which is
not CD audio quality. In order to encode files to MP3 format with better quality, you'll have to download/install
a better MP3 encoder. Freeware versions are available from the Internet or you can buy commercial software.

MP3 Encoders
As the technique used for MP3 encoding is partially protected, this Roni Music software doesn't include an
MP3 encoder of its own. There are a number of such encoders available commercially or as free downloads
from the Internet.
At the present time, this Roni Music software supports three MP3 encoders, BladeEnc (freeware), LAME
(freeware) and Frauenhofer ACM codec (advanced and professional).
LAME
There exists a very good MP3 encoder by the name of LAME ("Lame Ain't no MP3 Encoder"). As the name
implies, the program deals with Frauenhofer MP3 patent issues in an unusual way. It's distributed only as source
code and not as a compiled .exe. This appears to be legal. There are a lot of people constantly working on
improvements to the LAME MP3 encoder and it's not usually too difficult to find a version on the Internet. The
one that works with this Roni Music software is a version called lame_enc.dll. There’s no official download
location for this encoder but the home page can be found at: http://www.mp3dev.org/
Or search with Google (http://www.google.com) for “lame_enc.dll”.
Blade
There's also a good encoder by the name of BladeEnc. This encoder is also Freeware and produces good sound
quality. The author, Tord Jansson, has released a .dll called “BladeEnc.dll” that works very well with this Roni
Music software. Download the .dll, unzip it and place it in your this Roni Music software folder and you will
gain access to the MP3 encoding options.

You can download it from: http://bladeenc.mp3.no/
Note:
When using BladeEnc or LAME, the files bladeenc.dll or Lame_enc.dll should be placed in the same folder as
this Roni Music software so that the program can find them automatically. You may also elect to store them in
your Windows or Windows\System folder.
Fraunhofer acm Codec
An acm codec is a small program that works almost like a DLL file. This means that it has functions that can be
called from other programs but it can not be run separately.
Fraunhofer has made such a codec for MP3 encoding and this Roni Music software now supports both the
professional and the advanced (comes with Windows) version of it. This professional version has to be
purchased and is quite expensive but has a very good sound quality.
When correctly installed it will be listed in the Encoder drop down menu in the Encoding Settings dialog

Ogg Vorbis
Ogg Vorbis is a fully open, non-proprietary, patent-and-royalty-free, general-purpose compressed audio format
for high quality (44.1 - 48.0 kHz, 16+ bit, polyphonic) audio and music.
The Ogg Vorbis music encoding format is contemporary to MPEG-4's AAC and TwinVQ, the next generation
beyond MPEG audio layer 3. Unlike the MPEG sponsored formats (and other proprietary formats such as
RealAudio G2 and Windows' WMA), the Vorbis CODEC specification belongs to the public domain. All the
technical details are published and documented, and any software entity may make full use of the format
without royalty or patent concerns.
For this Roni Music software to be able to encode music into Ogg Vorbis format, you need to download and
install a free file called vorb_enc.dll from:
http://xtractor.sourceforge.net/vorbis.html
You can also download it from:
http://www.ronimusic.com/miscdownload.htm
Direct download:
http://www.ronimusic.com/download/ogg_vorbis_dll.zip

FLAC
FLAC stands for Free Lossless Audio Codec. Grossly oversimplified, FLAC is similar to MP3, but lossless,
meaning that audio is compressed in FLAC without any loss in quality. This is similar to how Zip works, except
with FLAC you will get much better compression because it is designed specifically for audio, and you can play
back compressed FLAC files in your favorite player (or your car or home stereo) just like you would an MP3
file.
Read more about the FLAC file format here:
http://flac.sourceforge.net/

Windows Media Audio
Windows Media Audio is Microsoft's answer to MP3. It is basically another file format for compressed audio
and the file extensions for such files are .wma. Microsoft claims that the sound quality should be the same for a
file that is only half the size of an MP3!
It is definitely a file format to check out and with the power of Microsoft promoting it, wma has a great chance
to be a widely used file format. The encoder and decoder don’t cost anything.
You can find more info at Microsoft’s own page:
http://www.microsoft.com/windows/windowsmedia/
This Roni Music software can now internally compress to Windows Media Audio or de-compress Windows
Media Audio files provided your computer supports wma files. If you have a recent version of Windows Media
Player, you will have the necessary files installed.

Microsoft PCM Converter
Microsofts PCM converter comes with Windows so it should be found on all computers. This is not really an
encoder, all it does is changing the bit per sample, frequency, or mono/stereo mode on wave files. Select the
Microsoft PCM converter with the Encoder drop down menu and set the desired setting. To be able to burn a
wave file to an audio CD the format MUST be 44100 Hz / 16-bit / Stereo.

Default Keyboard Shortcuts
This is a list of the default keyboard commands. You may change most of the commands in the Key Commands
dialog
[A]
[Ctrl] + [B]
[C]
[D]
[Ctrl] + [D]
[Ctrl] + [E]
Ctrl] + [G]
[H]
[Ctrl] + [I]
[Ctrl] + [J]
[K]
[Ctrl] + [K]
[L]
[Ctrl] + [L]
[Ctrl] + [M]
[O]
[Ctrl] + [O]
[P]

Select between Slow Down Type I, II, III and IV
Open Button Settings Dialog
Nudge loop backwards by one frame
Toggle processing on/off
Select CD Device Dialog
Eject CD
General Settings Dialog
Hold (sustain) a short section of audio
Remote Control Dialog
Miscellaneous Settings Dialog
Karaoke function On/Off
Keyboard Commands Dialog
Loop Mode On/Off
Clear preset settings
MIDI Control dialog
Auto Create Preset
Open an audio file
Toggle between no transposition / previous selected

[Ctrl] + [P]
[Q]
[Ctrl] + [Q]
[Ctrl] + [R]
[S]
[Ctrl] + [S]
[T]
[V]
[W]
[X]
[Z]
[Spacebar]
[0] (Num)
[ , ] (Num)
[Enter] (Num)
[1] (Num)
[2] (Num)
[3] (Num)
[4] (Num)
[5] (Num)
[6] (Num)
[7] (Num)
[8] (Num)
[9] (Num)
[+] (Num)
[ - ] (Num)
[ * ] (Num)
[/] (Num)
[F1]
[0]...[9] (Main keyb)
[Control] + [0]...[9]
[Shift] + [0]...[9] (Main keyb)
[Shift] + [Control] + [0]...[9]
[Home]
[End]
[Delete]
[Control] + [Up/Down arrow]
[Up/Down arrow]
[Left/Right arrow]

Show Windows Mixer / Playback section
Equalizer On/Off
Quit program
Refresh Track list
Stereo playback on/off
Save Track as Wave file
Toggle between full-speed and previous stretch value
Nudge loop forwards by one frame
Toggle CD/File player mode
Slide loop forwards
Slide loop backwards
Toggle between Play/Stop or Pause/Continue
Start Playing
Continue Playing
Stop Playing
Decrease End Position one second – add Control key for frame changes
Mark End Position
Increase End Position one second – add Control key for frame changes
Decrease Start Position one second – add Control key for frame changes
Mark Start Position
Increase Start Position one second – add Control key for frame changes
Set 90% speed – add control key for 50%
Set 75% speed – add control key for 33%
Set 66% speed – add control key for 25%
Increase Speed (More Time Stretch)
Decrease Speed (Less Time Stretch)
Raise Pitch - add shift key for minor changes
Lower Pitch - add shift key for minor changes
Menu Item Help
Recall preset
Store preset
Recall EQ preset
Store EQ preset
Set Start Slider to start position
Set End Slider to end position
Remove a file from the track list
Selects another track/file
Volume
Cue slider (fast forward/rewind)

Audio File Formats
Audio files are used to store digital audio. Audio files usually contain information about the included audio
waveform's characteristics and how it is stored. An audio file format usually specifies the sample rate, bit-depth,
and type of compression used as well as other information that indicates how long the waveform is, how much
data must be read per second of play-time, etc.

Most of an audio file's content is used to describe the individual audio samples that are played sequentially to
reconstruct the waveform. The waveform data can be compressed in different ways to help reduce the large size
of a stream of audio samples. Every minute of uncompressed CD quality (44.1 kHz, 16-bit, stereo) audio
requires about 10 MB of storage space.
Wave Files
Microsoft's Wave file format is the most commonly supported audio file format on the Windows platform. It is
capable of storing waveform data in many different formats. The most common type of wave files contains
uncompressed (raw PCM) waveform data. Even though compressed audio continues to become more popular
because of limited storage space, Wave files still tend to contain uncompressed waveform data while other file
formats (such as MP3 and WMA) are used for compressed data.
MP3 files
MP3 is a file format that stores music files on a computer in such a way that the file size is relatively small, but
the song sounds near perfect. You can identify MP3 files by the .mp3 ending. The size of an MP3 file is
typically 1 MB per minute of music.
MP3 files are actually MPEG-1 (MPEG version 1) or MPEG-2 (MPEG version 2) files. Both types can be
encoded as Layer I, Layer II or Layer III. Amazing Slow Downer can playback any of these types.
Note: There is also an unofficial standard called "Version 2.5" which Amazing Slow Downer support provided
you have Windows Media Player or QuickTime installed.
WMA - Windows Media Audio files
Microsoft’s respond to MP3, the Windows Media Audio standard is firmly integrated in Microsoft’s Windows
Media Player (WMP). Microsoft promises almost CD-quality with just a third of the source-file’s size. Above
all WMA offers the advantage that copyright-protected songs cannot be published any further (DRM - Digital
Rights Management).
If DRM (Digital Rights Management) is applied to a file it means that if you move them to another computer or
try to play it with a player that does not have a DRM license, it will not work.
If you use Windows Media Player to create wma files for personal use only, it’s best to turn off DRM.
To turn DRM off for all content you create in the future, go to Window Media Player's Tools Menu->Options>CD Audio and uncheck "Enable Personal Rights Management" which will result in DRM-free content from
that point forward.
For newer versions of WMP this is under Tools Menu->Options->Copy Music, "Copy Settings" section.
Uncheck the “Copy protect music” item.
AAC/MP4 - QuickTime files
AAC/MP4 files is another new file format that has nothing to do with Microsoft. On the contrary, this is a
format that competes with Windows Media Audio files (WMA) so to be able to playback those files on a
Windows computer you need to download and install QuickTime for Windows from Apple’s website at
http://www.apple.com/quicktime/
By installing QuickTime you automatically get support for some other file formats as AIFF and QuickTime
movie files when using Amazing Slow Downer.

You are probably only interested in AAC/MP4 files if you use Apple’s iTunes player. If so, your computer
already have QuickTime for Windows installed. This makes it possible for Amazing Slow Downer to play back
AAC/MP4 files, i.e. files that have .mp4 and .m4a as their file extensions.
Files purchased from the Apple iTunes store (.m4p files) are supported by Amazing Slow Downer but since
they are protected by a DRM (Digital Rights Management) license you are not allowed to re-save the files playback only. Other limitations are: worse sound quality, no pitch change, limited equalizing etc.
You may however burn the purchased songs to a CD - this way you can circumvent the DRM protection and
also re-save the files using Amazing Slow Downer.
Ogg Vorbis files
Ogg Vorbis is a fully open, non-proprietary, patent-and-royalty-free, general-purpose compressed audio format
for high quality (44.1 - 48.0 kHz, 16+ bit, polyphonic) audio and music.
The Ogg Vorbis music encoding format is contemporary to MPEG-4's AAC and TwinVQ, the next generation
beyond MPEG audio layer 3. Unlike the MPEG sponsored formats (and other proprietary formats such as
RealAudio G2 and Windows' WMA), the Vorbis CODEC specification belongs to the public domain. All the
technical details are published and documented, and any software entity may make full use of the format
without royalty or patent concerns.
FLAC (Free Lossless Audio Codec) files
FLAC stands for Free Lossless Audio Codec. Grossly oversimplified, FLAC is similar to MP3, but lossless,
meaning that audio is compressed in FLAC without any loss in quality. This is similar to how Zip works, except
with FLAC you will get much better compression because it is designed specifically for audio, and you can play
back compressed FLAC files in your favorite player (or your car or home stereo) just like you would an MP3
file.
Musepack files
Musepack is an audio compression format with a strong emphasis on high quality. It's not lossless, but it is
designed for transparency, so that you won't be able to hear differences between the original wave file and the
much smaller MPC file. It is based on the MPEG-1 Layer-2 / MP2 algorithms, but since 1997 it has rapidly
developed and vastly improved and is now at an advanced stage in which it contains heavily optimized and
patentless code.

Some thoughts about transcription
These are my personal thoughts and primarily based on my experiences as a teacher and working jazz musician.
I do, however, think they apply to all kinds of musicians.
Why transcribe?
Musicians have forever been transcribing and listening to other musicians in order to learn. Listening and
transcribing are a great way to learn a tradition that is, in fact, oral by nature. No book in the world can describe
how something sounds! You are training your ear, your instrumental skills, note writing, phrasing etc.
What should I transcribe? Is it “dangerous” to transcribe?
Depends on whom you are and what you're transcribing.

If you’re a beginner, this is the greatest way to understand what the big guys are doing (they've all been doing
exactly the same thing).
If you've come a bit further along the way, you should perhaps be a bit careful about transcribing your idols.
There’s a risk that you’ll just become a copycat. Rather, transcribe musicians that you feel are different from
yourself. Transcribe other instruments. Check out the older musicians that are the roots of your idols.
Don't just transcribe the notes, play along and try to copy the general feeling of the musicians and the things
they are playing.
Be careful if you’re using headphones. It's very tempting to increase the volume in order to hear what the
musicians are playing better. Doing so may damage your ears. Also, when playing in loud environments, always
use earplugs of some kind. Tinnitus is becoming more and more common.
How to transcribe?
Begin by playing along with the tune. If you have the sheet music, learn the original version (melody and
harmony).
Continue transcribing the harmonies to see if they are the same. If you know the harmonies it's much easier to
understand what the performer is doing.
Start transcribing at full speed, slow down the speed only when it's too fast for your ear to comprehend or when
your instrumental technique isn't up to it.
As you go along, write it down. If your note writing skill is bad, do it anyway! This way you improve this skill,
too. After a while, when you've forgotten what you learned, it's very easy to remember it with the help of the
written score. Besides, many of you may, sooner or later, find yourselves in a teaching situation and this will
give you some great material to work with.
How exact should I be?
That depends.
If you're planning to write a book or to use the material for teaching, then you should be as careful as possible.
If you're transcribing for your own personal pleasure, you don't have to be as exact. The point is to learn
something new and improve your skills.
Switch between transcribing and practicing. Often, a couple of notes or phrases is enough to give you a lot of
new ideas to work on.

